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FormPower Overview

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen or the Overview button to return to this screen.

Click on an area of the dialog box for further explanation.



This section indicates the current subdirectory.    Use the section below to change to a different 
subdirectory.



This area of the dialog box shows a listing of files available in the current subdirectory.    Notice 
that the file listing is shaded to help prevent using a file name that is already used.    If a tab is in 
the scroll bar at the left edge of this area, use it to search for additional file names.    You can 
indicate the type of files you want listed by clicking on the arrow in the section just below.



Type in the name of the form you want to open.    The section below will search for matching file 
names as you type.



Open dialog box / Fillout dialog box

Select the name of the file to open by using the File-Open command for master or fillout forms.   
Master forms containing fields can be opened for fillout by using the File-Fillout command.    The
dialog window title will indicate which command was selected.

Click on an area of the dialog box for further explanation.



Click on the Cancel button to close and disregard all settings in the dialog box.



Click on the OK button to accept the the setting indicated in the dialog box.



Border settings for the page are not shown as part of the display during form design.    Settings 
in this area represent a non-printable edge on the indicated side of the paper.



Adjust the dimensions of the area usually to match the size of the paper being used or smaller 
than the output paper.    e.g. Set Width to 11.00 and Height to 8.50 for standard size landscape 
printing.



Choose an appropriate selection for any output such as a standard portrait Letter, Legal or 
Legal2 output.    You can highlight the last option in this section and indicate in the section to the 
right a size not listed, such as legal landscape (Width 14", Height 8.5").



The main window Title bar displays the FormPower program name and the name of the active 
open form window.

The Form window Title bar indicates the name of the form. If the form is active, the title bar is 
highlighted.

Note:  Watch for an asterisk (*) symbol at the end of a file name in the Title bar.    This is an 
indication that the form file has been modified.    All changes will be lost if the file is not saved 
before exiting FormPower.



An icon within FormPower client area (window) indicates an open form that has been minimized
to clear workspace.    The name of the opened form file is displayed below the icon symbol.    
Several opened forms may be iconized at once in order to clean up the form display area.    
Double-click on the icon to bring the form back into the foreground and make it the active 
window.



File menu commands

The File menu offers the following commands:

New Creates a new form.
Open Opens an existing form.
Fillout Fillout a form that contains data entry fields.
Close Closes the active form window.
Save Saves an opened form using the same file name.

Save As Saves an opened form to a specified file name.
Save All Saves all modified forms that have not yet been 

saved to disk.
Print Prints a form.

Print Preview Displays the form on the screen as it would 
appear printed.

Print Setup Selects a printer and printer connection.
File 1, 2, 3, 4 List of the four most recently opened forms.

Exit Exits FormPower.



Edit menu commands

The Edit menu offers the following commands:

Select Enables Select drawing mode.
Cut Deletes data from the form and moves it to the 

clipboard.
Copy Copies data from the form to the clipboard.
Paste Pastes data from the clipboard into the form.

Delete Removes the currently selected text or object.
Undelete Restores the last deleted text or object.

Insert New Object Insert an OLE object into the form.
Links List and edit links to embedded documents.

Object verb Menu selection varies depending on highlighted 
object.

Fillout Fillout data fields in the current form
Clear All Clears all text or all objects.



View menu commands

The View menu offers the following commands:

View Scaling commands:
100 % View at full size..

75 % View at 75% of full size.
50 % View at 50% of full size.

200 % View at twice full size.
Custom % User definable view scale.
Custom % User definable view scale.

Toolbar Show or hide the toolbar.
Status Bar Show or hide the status bar.

Refresh Updates the screen.



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple form 
windows within the main FormPower program window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.

Arrange Icons Arranges icons of minimized windows.
Close All Close all opened form widows.

Window 1, 2, ... Activates specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with FormPower:

Contents Displays the help Table of Contents.
Overview Displays a quick FormPower overview.

Using Help Provides general instructions on using help.
About Displays the version number of FormPower.



New command (File menu)

Use this command to create a new master form.    The Form Layout dialog box will appear to 
allow selection of form dimensions and margins.

You can open an existing master or fillout form with the Open command.

Shortcuts

Toolbar:

Keys: Ctrl+N



Open command (File menu)

Use the Open command to open an existing form in a new window.    You can open multiple 
forms at once.    Use the Window menu to switch among the multiple open forms.    See Window 
1, 2, ... command.

Choose Fillout to open a form containing fields for data entry.

Select the name of the form you want to open in the Open dialog box.

You can create new forms with the New command.

Note: The single user, non-network version of FormPower will not read-from or save-to a 
network drive.

Shortcuts

Toolbar:

Keys: Ctrl+O



Close command (File menu)

Use this command to close an active form window.    When the form is modified, a save prompt 
will appear.    If you close a modified form without saving it, you lose all changes made since the 
last time you saved it.    Before closing an untitled form, FormPower displays the Save As dialog 
box and suggests that you name and save the form.

You can also close a form by double-clicking the Close icon on the form's window, as shown 
below:



Save command (File menu)

Use this command to save the active form to its current name and directory.    When you save a 
form for the first time, FormPower displays the Save As dialog box so you can name your form.   
If you want to change the name and directory of an existing form before you save it, choose the 
Save As command.

Shortcuts

Toolbar:

Keys: Ctrl+S



Save As command (File menu)

Use this command to save and name or rename the active form.    FormPower displays the 
Save As dialog box so you can name your form.    

To save a form with its existing name and directory, use the Save command.

Note: The single user, non-network version of FormPower will not read-from or save-to a 
network drive.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:

Click on an area of the dialog box for further explanation.



1, 2, 3, 4 commands (File menu)

Numbers and file names listed near the bottom of the File menu list the last four forms you 
opened.    Choose the number that corresponds to the form you want to open, or click on the 
name with the left mouse button.



Exit command (File menu)

Use this command to end your FormPower session.    You can also use the Close command on 
the FormPower Control menu.    FormPower prompts you to save forms with unsaved changes.

Shortcuts
Mouse:  Double-click FormPower's Control menu button.

Keys: Alt-F4



Undo Delete Command (Edit menu)

Use this command to reverse the last delete, if possible.

Shortcuts

Keys: Ctrl+Z or
Alt+Backspace



Cut command (Edit menu)

Use this command to remove the currently selected (highlighted) object or text from the form 
and put it into Windows' clipboard.    The Paste command can then be used to copy the 
clipboard contents to another form, or to elsewhere on the same form.

This command is unavailable if no object or text is selected.

Cutting data to Windows' clipboard always replaces any previously stored contents.

Shortcuts

Toolbar:

Keys: Ctrl+X



Copy command (Edit menu)

Use this command to copy the currently selected (highlighted) object or text from the form and 
put it into Windows' clipboard.    The Paste command can then be used to copy the clipboard 
contents to another form, or to elsewhere on the same form.

This command is unavailable if no object or text is selected.

Copying data to Windows' clipboard always replaces any previously stored contents.

Shortcuts

Toolbar:

Keys: Ctrl+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents into the form.    This command is 
unavailable if the clipboard is empty.

When pasting an object, the new object is placed at a position similar to the original object.    
The new object is also automatically selected.

The Cut and Copy commands can place text or objects into the clipboard.    The Paste 
command then places a copy of the current clipboard contents into the form, even when the 
clipboard contains text or objects that were copied or cut from another form.    Text and OLE 
objects can be copied from other applications.

Shortcuts

Toolbar:

Keys: Ctrl+V



Toolbar command (View menu)

Use this command to display or hide the Toolbar, which includes buttons for some of the most 
common commands in FormPower, such as File Open.    A check mark appears next to the 
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the FormPower main window, below the menu bar.    
The toolbar provides quick mouse access to many tools used in FormPower,

To hide or display the Toolbar, choose Toolbar from the View menu (Alt, V, T).

Click on an area of the toolbar for further explanation.



Adjust the dimensions of the area usually to match the size of the paper being used or smaller 
than the output paper. Set Width to 11.00 and Height to 8.50 for standard letter size landscape 
printing. Sometimes the printer driver will also have to be adjusted for portrait or landscape.



Status Bar command (View menu)

Use this command to display or hide the Status Bar.    The Status Bar displays pertinent 
information, including the current mode and mouse position.    It also provides a micro-help for 
the current command being selected from the menu or toolbar.

A check mark appears next to the menu item when the Status Bar is active.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the FormPower window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar (also know as micro-Help) describes actions of menu items as 
you use the arrow keys to navigate through menus.

This area similarly shows “fly-by” messages that describe the actions of toolbar buttons as the 
cursor passes over them.

Further to the right, two numeric values are displayed, representing the horizontal and vertical 
mouse position on the form relative to the upper-left corner. 

Another indicator will display "Master", or "Fillout" depending on the function mode you are in.

The far right area of the status bar indicates which of the following keys are set (check your 
keyboard for a light or other indication):

CAP The Caps Lock key is set.
NUM The Num Lock key is set.
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Cascade command (Window menu)

Use this command to arrange multiple open windows in an overlapped fashion.



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



An icon representation is used.for OLE objects that cannot be displayed, such as sound files.    
You can choose a different icon with the Change Icon button.



Arrange Icons command (Window menu)

Use this command to arrange icons for minimized windows at the bottom of the FormPower 
window.    If there is an open form window at the bottom of the main window, then some or all of 
the icons may not be visible because they will be behind this form window.



1, 2, ... commands (Window menu)

FormPower displays a list of currently open form windows at the bottom of the Window menu.    
A check mark appears in front of the form name of the active window.    Choose a form from this 
list to make its window active.



Overview command (Help menu)

Use this command to display the Overview Help screen.    From the opening screen, you can 
step through instructions for using FormPower by reading the reference information provided.

At anytime during Help, you can click the [ Contents ] button to return to the opening screen, or 
click the [ Overview ] button to return here.

Add your own notes to the help file by using Help's Edit Annotate command or the Annotate 
toolbar button.    All annotations are saved in the Windows program subdirectory as filename 
FP.ANN.    These annotations can only be modified and viewed during display of this help file.    
As a reminder, annotated topics will display a paper-clip icon to the left of the topic title.



Using Help command (Help menu)

Use this command for detailed instructions about how to use the Windows Help program.



About command (Help menu)

Displays the copyright notice and version number of your copy of FormPower™    version 1.0.

FormPower™    version 1.0 is    © 1994 by EZX Corporation, all USA and 
International rights reserved.

Distributed by:
EZX Publishing & Distributing
EZX Corporation
917 Oakgrove Drive, Suite 101
Houston (Webster), TX    77058-3046    USA

Mailing Address:    EZX Corp.,    PO Box 58177,    Webster (Houston), TX 77598-8177    USA

Credit Card Orders (Visa, MasterCard, Discover, American Express) may call the ORDER 
DESK @ 1.800.800.2468 (toll free in the USA)

Phone Numbers for all other business and International:
•Voice 713-280-9900 (Business hours, Central USA Time Zone)
•FAX In: 713-280-0099 (24 hours)
•Fax-On-Demand: 713-280-8300 (from your FAX machine handset. Same call FAX-back.)
•EZ-Host BBS: 713-280-8180 (24 hours; to 14400 N,8,1)



Context Help command

Use the Context Help command to obtain help on a specific FormPower function.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Click somewhere in the FormPower window, such as another Toolbar button, or
pulldown menu.    The Help topic will be shown for the item you click on, if it applies.

Shortcut
Keys: Shift-F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and 
the active form.

To move the window, drag the title bar to the desired position.

Note: You can also move dialog boxes by dragging their title bars.

A title bar may contain the following elements:
Application Control-menu button
Form Control-menu button
Maximize button
Minimize button
Name of the application
Name of the form
Restore button

Note:    Watch for an asterisk symbol (character above the number 8 key, between the    “7”    key
and the    “9”    key just above the letter keys) at the end of the file name.    This is an indication 
that the form file has been modified.    All changes will be lost if the file is not saved before 
exiting FormPower. Don't worry, you'll be prompted as necessary.



Scroll bars

Scroll bars are displayed at the right and bottom edges of the form window when the form 
exceeds the size of that window.    The scroll boxes inside the scroll bars indicate your vertical 
and horizontal view of the form.    You can use the mouse to bring other parts of the form into 
view.



Scroll bars

Displayed at the right and bottom edges of the form window.    The scroll boxes inside the scroll 
bars indicate your relative vertical and horizontal position within the form.    You can use the 
mouse to bring other parts of the form into view.



Size command (Control menu)

Click on the upper left corner (control tab) of the form window and select size.

Use this command to display a four-headed arrow so you can size the active window with the 
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the 
pointer to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog 
box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: Ctrl+F7



Minimize button

The Minimize button of a form window will iconize the active window and display the icon within 
the FormPower client area, usually at the bottom.

Shortcut

Mouse: Click the minimize icon  on the title bar.



Maximize button

The Maximize button for a form window will expand the window to full FormPower client window
size and set the currently active window display to be the default until changed.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.



Next Window command (form Control menu)

Use this command to switch to the next open form window.    FormPower determines which 
window is next according to the order in which you opened (or last edited) the windows.

Shortcut
Keys: Ctrl-F6



Close command (Control menus)

Use this command to close the active window or dialog box.
Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open, the Close command on the form Control menu 
closes only one window at a time.    You can close all windows at once with the Close-All 
command in the Window menu.

Shortcuts
Keys: Ctrl+F4    closes a form window

Alt+F4    closes a dialog box



Restore command (Control menu)

Use this command to return the active window to its previous size and position, before you 
selected the Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or 
close an application on the list.

Shortcut
Keys: Ctrl-Esc

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar.    This option does 
not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Object Convert dialog box

This dialog can vary greatly depending on what OLE server applications are available on your 
system.    An OLE object can only be converted when there is another object type available.

Click on the appropriate area of the dialog box for further explanation.



Keyboard “Hot Keys”

Text and Field Edit Objects

Arrow keys Cursor movement
Home Beginning of line
End End of line
Ctrl + Home Beginning of text
Ctrl + End End of text
Ctrl + Left Previous word
Ctrl + Right Next word
Shift Add to any above key to select text
Insert Toggle insert/overstrike mode
Delete Delete a character to the right
Enter Terminate text entry
Ctrl + Enter Force new line
Alt + Backspace or 
Ctrl + Z

Undo

Fillout Mode

Arrrow keys Cursor movement
Tab Next field (Options-Preferences-Tab between 

fields toggled ON)
Shift + Tab Previous field (Options-Preferences-Tab between

fields toggled ON)
Enter Next field
Shift + Enter Previous field

Form / Window Movement

PageUp Scroll up page
PageDown Scroll down page
Ctrl + PageUp Scroll left page
Ctrl + PageDown Scroll right page
Ctrl + Home To First field
Ctrl + End To Last field
Ctrl + Up Scroll up line
Ctrl + Down Scroll down line

Desing Mode

Arrow keys Micro-Move selected object
Shift + Arrow keys Move selected object
F2 Turn on / off snap-to-grid (see Options Grid 



command)

Menu Hot Keys

Ctrl + Key combinations:
Ctrl + N File - New
Ctrl + O File - Open
Ctrl + F File - Fillout
Ctrl + S File - Save
Ctrl + P File - Print
Ctrl + X Edit - Cut
Ctrl + C Edit - Copy
Ctrl + V Edit - Paste
Ctrl + Z Edit - Undo Delete
Ctrl + R Refresh Screen to eliminate screen movement 

artifacts.
Ctrl + F4 Form Control - Close
Ctrl + F6 Form Control - Next

Alt + Key combinations:
Alt + F4 Program Control - Close
Alt + Backspace Edit - Undo Delete



Sound Card.
An icon representing a prerecorded sound file can be placed on a form.    Sound files stored in 
the .WAV format can be played during data entry for instructions, or to further “illustrate” a topic. 
(e.g. telephone ringing, or other sounds)    Use the Edit-Insert New Object command to place an 
icon on your form that will play back the sound file.    Choose "Create from File", enter the sound
file name, then OK.

Check the recording section of your sound card manual for instructions on how to create your 
own sound files and use them in forms you design.    The user of your form will be able to click 
on an icon to listen to the file associated with the icon.    Embedding the sound file with an 
automatic link will keep the sound file seperate from the form.

Sound files will only be played if your system has the proper Windows sound drivers and 
hardware installed. Consult your sound card supplier for more details.

See Also

Inserting OLE Objects



A format contained in a file, which specifies how data is to be presented on the screen or printer.
Forms can contain data fields, fixed text, printing attributes and graphics.



Clear All (Edit menu)

Design Mode

This provides a quick and convenient way to clear all objects in a form.    Prompts for 
confirmation first.    The resulting form is blank, identical to the blank form created by the Form 
New command.

Fillout Mode

This provides a quick and convenient way to clear the contents of all fields in a form.    Prompts 
for confirmation first.    The resulting form has all blank fields, identical to the form loaded by the 
File Fillout or Edit Fillout commands.



Contents command (Help menu)

Use this command to display the opening Help screen.    From here you can select any of the 
main help topic categories, including both instructional and reference information.

At any time you can click the [Contents] button to return to the Contents screen.

Add your own notes to the help file by using Help's Edit Annotate command or the Annotate 
toolbar button.    All annotations are saved in the Windows program subdirectory as filename 
FP.ANN.    These annotations can only be modified and viewed during display of this help file.    
As a reminder, annotated topics will display a paper-clip icon to the left of the topic title.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Links command (Edit menu)

Use this command to display a    Links dialog box which lets you edit OLE links between your 
form and other documents.

This command is only available in Design Mode, and only available when you have at least one 
link in your form.

See Also

Inserting OLE Objects



Links dialog box

The following options are available in the Links dialog box:

Click on an area of the dialog box for further explanation.



Object verb (Edit menu) 

Design Mode

The Edit Object command opens the OLE server application that has been selected to maintain 
the object.    The object is automatically loaded into the OLE server.    This command is available
only when you have selected an existing OLE object.    You will be in another application, not 
FormPower, while you edit the object.    When you finish editing, choose File-Update in the OLE 
server application menu.    FormPower then incorporates the changes into your form.    This 
menu's name changes depending on the object you select.

The Object Convert command opens the Convert dialog box.

There may be more than one verb listed.    The first listed verb is always the Primary Verb, and 
the remaining are Secondary Verbs.    The actual commands depend on the OLE server for the 
object.    For example, the Media Player program that is part of Windows lists Play as the 
Primary and Edit as the Secondary Verb.

Fillout Mode

The Primary verb is available in Fillout Mode by double-clicking on the object with the mouse left
button.

Shortcut

Mouse: Double-click the object with the left mouse button.



Insert New Object command (Edit menu)

Use this command to insert an OLE object from an OLE server application.    The OLE server 
will become the active application until you exit or cancel the session.

Select the OLE object you want to insert into your form by using the Insert New Object dialog 
box.    This command is only available in Design Mode.

See Also

Inserting OLE Objects



Print command (File menu)

Use this command to print a form.      Presents a Print dialog box, where you may specify 
number of copies, destination printer, and other printer setup options.

Note: Make sure your printer landscape or portrait setting corresponds to the size and type of 
your form.

Shortcuts

Toolbar:

Keys: Ctrl+P



Print dialog box

The following options allow you to specify how the form should be printed:

Click on an area of the dialog box for further explanation.

Print Progress Dialog

A small Print dialog box is shown during the time that FormPower is sending output to the 
printer, or Print Manager (if in use).
Print progress is also displayed.

To abort printing, choose Cancel.



Specify the number of copies you want to print for the above page range.



Print Progress Dialog

The Printing dialog box is shown while FormPower is sending output to the printer.    The page 
number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to preview how the active form will look on paper.    This can minimize the 
amount of paper used to print out intermediate copies during Master Form design.

When you choose this command, the main window will be replaced with a print preview window. 
The Print Preview toolbar offers you selections that change the view; move back and forth 
through the form; zoom in and out of pages; and can even initiate a print job.



Draw Menu commands

The Draw menu offers the following commands:

Line Draw lines vertically, horizontally, or angled.
Rectangle Draw squares or rectangular shapes.

RoundRect Draw squared and rectangular shapes with 
rounded corners.

Ellipse Draw circles or stretch the circle to any horizontal
or vertical length. A stretched circle is an ellipse.

Text Create a text object within the form.
Field Add data entry fields in specific locations on the 

form.
Select Enables Select drawing mode.



Print Preview toolbar

The print preview toolbar offers you the following options:

Click on an area of the dialog box for further explanation.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    Presents a Print Setup dialog 
box where you specify the printer, its connection, and page orientation.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Click on an area of the dialog box for further explanation.



Indicates the current subdirectory.    Change to a different subdirectory using the scroll bar or 
clicking on a directory name.    If a directory is not shown it may be that it is located as a 
subdirectory below the one just above the current subdirectory.    Try clicking on a directory 
name that is one or two above the current subdirectory.



Click on the arrow to change the type of files listed in the section just above.



In design mode only, to access this menu move the mouse pointer over an object and click the 
right mouse button.    Continue to hold the button until you make a selection from the menu.



Click on the arrow to display other available drives.



Click on the Help button in any dialog box to open a help screen that will explain the task or 
topic.



If you are connected to a network file server or workgroup, this button will activate your available
network services.

Note:    The single user version of FormPower does not support network drive or services 
access even though the Network button may be active.



This section indicates the current subdirectory.    Use the section below to change to a different 
subdirectory.



Type a new filename to save a form with a different name.    A filename can contain up to eight 
characters followed by a period and then an extension of up to three characters.    FormPower 
adds the extension. You specify the file name in the Save File As Type box.



This area of the dialog box shows a shaded listing of files in the current subdirectory.    The 
listing may help in naming the new file if you've forgotten some the the filenames already used.   
You can indicate the type of files you want listed by clicking on the arrow in the section just 
below.



Indicates the current subdirectory.    Change to a different subdirectory using the scroll bar or 
clicking on a directory name.    If a directory is not shown it may be that it is located as a 
subdirectory below the one just above the current subdirectory.    Try clicking on a directory 
name that is one or two above the current subdirectory.



Click on the arrow to change the type of file listed in the section just above.
Available choices are:

Master Forms. (*.frm)
All Files (*.*)



Click on the arrow to search for files on a different drive.



This is the active printer and printer connection.    Choose the Setup option to change the printer
and printer connection.



Specify the pages you want to print:
    All Prints the entire form.
    
Selection

Prints the currently selected text.

    Pages Prints the range of pages you specify in 
the From and To boxes.



Select the quality of the printing.    Generally, lower quality printing takes less time to output on 
any printer.



Prints copies in page number order, instead of separated multiple copies of each page.



Displays a Print Setup dialog box, so    you can select a printer and printer connection.



Access the Print dialog box, to start a print job.



Unsupported.    Preview the next page.



Unsupported.    Preview the previous page.



Preview one or two pages at a time.



Take a closer look at the page. (Make it bigger on screen. Less of the page appears on screen 
with higher resolution.)



Take a larger look at the page. (More of the page appears on screen with lower resolution.)



Return from Print Preview to the main window.



Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer 
option to select one of the currently installed printers shown in the box.    You may install other 
printers and configure ports (LPT1:, etc.) using Windows' Control Panel.



Choose Portrait or Landscape for printed page orientation.



Paper Size
Select the size of paper that the form is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.



Displays a dialog box where you can make additional choices about printing specific to the type 
of printer you have selected. This function is not attributable to FormPower, but the “printer 
driver” you have selected for your system. Printer drivers may come from Microsoft and/or the 
printer manufacturer.



Displays all links in a form. The four columns contain the application, filename, item name, and 
type or status of link.



Choose an appropriate selection for any output such as a standard portrait Letter, Legal or 
Legal2 output.    You can highlight the last option in this section and indicate in the section to the 
right for a size not listed, such as legal landscape (Width 14", Height 8.5").



Select the type of link you want for the selected links in the Links box:
Automatic Inserts new data as soon as it is available.
Manual Inserts new data only when you ask for it by choosing the Update-Now button.



Updates all links selected in the Links box, and then closes the dialog box.



Opens the source of a selected link.    For example: choosing the Open Source button opens up 
a linked chart in Lotus 123 for Windows or Microsoft Excel if you have either chart linked to your
form.



Change Source dialog box

Change the selected link to receive data from another application, file, or item. 

Click on the appropriate area of the dialog box for further explanation.



Breaks links for all selected links between data and the form, and then closes the Links dialog 
box.



Create a new form.    FormPower displays the Layout dialog box used for newly created form 
designs.



Open an existing form.    FormPower displays the Open dialog box, in which you can locate and 
open the desired file.



Save the active form or template with its current name.    If you have not named the form, 
FormPower displays the Save As dialog box.



Selected objects can be removed by using the Cut toolbar button or the Edit-Cut command.    
Object is placed in temporary storage on the Windows clipboard.



Insert the contents of the clipboard at the current cursor position in the form.    Position the 
cursor on the form where you want the object placed before pasting.    Objects can be pasted by
using the Paste toolbar button or the Edit-Paste command.



Make a duplicate copy of the selection to the clipboard.    Selected objects can be duplicated by 
using the Copy toolbar button or the Edit-Copy command.



Preview the active form on screen.    Click on this toolbar button or select the File-Print Preview 
command.



Print the active form.    Be sure to check the Printer Setup dialog box for things like page 
orientation, selecting the correct printer, etc.



Opens FormPower Help screen to the Contents screen.



Use the Context Help command to obtain help on some portion of FormPower.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the FormPower window, such as another Toolbar 
button.    The Help topic for the item clicked-on will be displayed.

Shortcut
Keys: Shift-F1



Select command (Edit menu)

When designing a master form, the Select command actives select mode.    Click on the Select 
Toolbar button, or use either the Edit-Select or Draw-Select commands.    Once in select mode, 
an object is selected by placing the mouse cursor anywhere on the object and clicking the left 
mouse button.    A selected object can be cut, copied, moved, resized or have its attributes 
modified.



Line command (Draw menu)

Line Drawing tool.    Activate by clicking on the Line Toolbar button, or by selecting the Draw-
Line command.    Position the mouse pointer to where you want to begin drawing, press and 
hold the left mouse button while dragging the mouse to draw the line to the desired length.    
Release the mouse button when done.    When the Snap-to-Grid option is selected in the Grid 
dialog box, the line's end points will "snap" to the nearest grid points.

See Also

Modifying Object Attributes



Rectangle command (Draw menu)

Rectangle Drawing tool.    Activate by clicking on the Rectangle Toolbar button or by selecting 
the Draw-Rectangle command.    Position the mouse pointer to where you want to begin 
drawing, press and hold the left mouse button while dragging the mouse to draw the rectangle 
to the desired size.    Release the mouse button when done.    When the Snap-to-Grid option is 
selected in the Grid dialog box, the rectangle's corner points will "snap" to the nearest grid 
points.

See Also

Modifying Object Attributes



RoundRect command (Draw menu)

Rounded Rectangle Drawing tool.    Activate by clicking on the Rounded Rectangle Toolbar 
button, or by selecting the Draw-RoundRect command.    Position the mouse pointer to where 
you want to begin drawing, press and hold the left mouse button while dragging the mouse to 
draw the rounded rectangle to the desired size.    Release the mouse button when done.    When
the Snap-to-Grid option is selected in the Grid dialog box, the encompassing rectangle's corner 
points will "snap" to the nearest grid points.

Note
At the top right of the highlighted object there is a tab on the inside corner used to adjust the 
corner arch for all four corners.

See Also

Modifying Object Attributes



Ellipse command (Draw menu)

Ellipse Drawing tool.    Activate by clicking on the Ellipse Toolbar button, or by selecting the 
Draw-Ellipse command.    Position the mouse pointer to where you want to begin drawing, press
and hold the left mouse button while dragging the mouse to draw the ellipse to the desired size. 
Release the mouse button when done.    When the Snap-to-Grid option is selected in the Grid 
dialog box, the encompassing rectangle's corner points will "snap" to the nearest grid points.

See Also

Modifying Object Attributes



Text dialog box

Choose justification, margins, etc., for Text and Field objects.    When accessed with the 
Options-Defaults-Text menu, text selections will only affect newly created objects.

The text characteristics of any Text or Field object can be altered after placement by using the 
Form Text command, accessible from the main menu or the object popup menu.    The dialog 
box title will not include "Defaults" when modifying an existing object.

Hint:  Double-click on an existing Text object to quickly change to text edit mode.

Click on an area of the dialog box for further explanation.



Set the properties for any given text or field object to the left, center, or right side of that area.    
Settings here are used for both Text areas and Field areas.



Use this section to adjust margin setting within Text and Field objects.    Fine adjustments and 
character alignment are possible with this method.



Add a border around Text or Field object.



Use this dialog box to add color to your form's text, lines, boxes, etc.

Basic Colors

The current color selection is indicated by the shadowed box.
To select a new color, click on the color with the mouse or move the shadowed box with the 
arrow keys.

Custom Colors

This feature is unsupported by FormPower.



Font dialog box

Choose font name, style etc. for Text and Field objects.    When accessed with the Options-
Defaults-Font menu, font selections will only affect newly created objects.

The font characteristics of any Text or Field object can be altered after placement by using the 
Form Font command, accessible from the main menu or the object popup menu.

Click on an area of the dialog box for further explanation.



Type in the name of the font, or use the section below to select from available fonts.



Shows fonts that are available on your system.



Type in the font attribute you want, or select from choices below.



Attributes available for the font selected to the left.



Type in the font size you want even if the size is not an available choice in the section below. 
Some sizes may not be visible or printable on certain systems.



Select the font size you want, or enter a different size in the section above.



Additional character attributes for both Text and Field objects.



Displays the character set as defined in other sections of this dialog box.



Click on the arrow to view a selection of colors for the font chosen.



Three of the most commonly used view choices from the six available.

Note:  Two view settings selectable from pulldown menu View are user definable.    Default 
settings for these custom view scales are defined by selecting Options-Preferences.

Four standard viewing scales are selectable from the pulldown menu and three of the most 
commonly used are available on the Toolbar.    Two additional custom scales are user definable 
in the Options-Preferences dialog box and are displayed in the pulldown menu.

The two custom scales can be adjusted to settings you prefer.    In the Options-Preferences 
dialog box there are two fill in areas where you define the view settings.    Accepted values are 
25% through 300%.



Font command (Options-Defaults menu)

The settings assigned in the Options-Defaults-Font dialog box are used to set defaults for all 
newly created text and field objects.



Fillout command (File menu)

Use the Fillout command to open a new window and load an existing Master Form that contains
field objects.    These field objects then become fields that can be filled out.    You can open 
multiple forms simultaneously.    Use the Window menu to choose the active form.    See Window
1, 2, ... command.

Select the name of the form you want to open in the Fillout dialog box.

You can create new forms with the New command.

Shortcuts

Keys: Ctrl+F



Save All command (File menu)

This command is used when there are two or more form windows open, that have been 
modified.    Saves all open form files so you do not have to step through the save procedure for 
each and every one of them.



Delete Command (Edit menu)

Use the Del key, or the Edit-Delete command to delete the currently selected object from the 
form.

While entering text in design mode, or during fillout mode, this command will delete selected 
text or the character to the right of the cursor.



FormPower™ is the the Ultimate Forms Processor for Windows!

Create, Modify, or Fill-in your own form in minutes!

• Whether your business is small or large, you can easily and quickly Create, Fill-in (internally 
generated forms),    Fill-out (pre-printed forms), Save, Save-as, Revise, and-or Print all kinds of 
forms in minutes.

 •Create custom forms (lines, boxes, etc.) on screen and add fill-out fields, clip art, graphic 
images, signatures, scanned photographs, and even video movies (e.g.. .AVI) or sound clips 
(e.g..      .WAV) via Windows' OLE feature!

• You can save time and money by having your existing forms and logos scanned to graphic 
(e.g.. .BMP) image files.    Adding filler "fields" creates your own filled-in forms. Its that "EZ"! 

• You can even fill-out pre-printed forms!

FormPower™ for Windows is here!!!

FormPower is GREAT FOR:
• Perfect form fill-out.
• Commercial Printers ... speeds form design, modification.
• In house publication departments ... Improve response time, ease update process, cut costs.
• Low cost forms development ... Develop and print all of your forms without outside help.
• Printing any quantity of custom forms on your laser printer on demand!

••• Great for basic desktop publishing too!

• FormPower's focus is on forms design, production and fill-out.    Unlike page document 
composition, the logical object oriented drawing tools are specifically tailored and optimized for 
forms design and manipulation. Its WYSIWYG (what-you-see-is-what-you-get) interactive 
screen is clear, intuitive and easy to use. Font size, typeface and printer options (including FAX 
transmission) are limited only by what is available under Microsoft Windows 3.1 for your system.



For truly flexible forms production, you can even print the filled-in data and the form at the same 
time or, fill-out to pre-printed forms.

CREATE TYPESET QUALITY FORMS IN HOUSE:
• You can design and modify your forms instantly. Creating a new form in house gives you 
complete control over the process.    Feedback on how it looks is immediate. You can design 
forms for cut sheet and continuous forms applications. Print your new design on your laser 
printer, or for even higher resolution, send Postscript output to a phototypesetter. By retaining 
control of the forms design, you can lower the costs and turnaround time without sacrificing 
quality. By printing your own on demand forms on your laser printer, you can economize by 
reducing stock of pre-printed forms. Another benefit is the reduction of obsolescence of forms.

• You can easily customize any of the 60+ included form templates to create any new form you 
desire.

DESIGN FORMS QUICKLY and EASILY:
• Using the display screen and mouse, you can perform fully interactive forms composition by 
creating and manipulating various "objects".
• WYSIWYG means that the screen looks like the final printed from, showing typefaces, font 
sizes, lines, rectangles, rounded rectangles, ellipses, circles, shading, logos, etc. Size any 
object for creative impact.    
• Text can be automatically word-wrapped, justified (left, center, right), fonted, colored, etc. in 
any text or fill-out field. 

INCORPORATE GRAPHICS AND PATTERNS:
• Logos, signatures and scanned images can be added to your form. Tools are provided to crop,
scale, copy, delete and move images and objects like text, lines, fill-out fields, etc..

Other Form Design and Fill-out Features include:
• Extensive on-line help and manual.
• On-screen grid (user adjustable; does not print) and snap-to-grid allow very quick and precise 
positioning of all objects and fields.
• Fill-out master or modify completed forms. No need to retype redundant information.
• Open multiple forms at once for quick reference or cut-and-paste.
• Multiple form views can be full window, window cascade, tile view, or reduced to icons.
• Six different working view magnifications (2 are user adjustable) 25% to 300% are available for
even the most intricate work.
• Precise continuous coordinate display for accurate positioning.
• Tool bar and status line control allow you to customize appearance and operation of the 
program.
• Copy, cut, and paste objects between multiple FormPower forms.
• Define page sizes, margins, layouts, orientation.
• Draw lines, boxes, shapes, fill patterns of many types, change orientation and color.
• 26 drawing tools are provided form design. There are five pen line styles, ten thicknesses and 
eight brush patterns.
• Other drawing tools include rectangle, round rectangle, and ellipse which can be melded with 
any of the brush patterns.
• Fill-out fields can be placed anywhere on the form, and in fill-out mode, the master part (or 
background) of the form cannot be modified so as to assure perfectly filled out forms every time.
• Print preview any form before committing to hard copy.
• Print to any Windows supported device, even directly to your FAX-modem (third party drivers 



required) for immediate transmission of your form.
• Use any Windows font including Bar Codes, and special characters like Wingdings.
• Quickly bold, underline, italicize, strike-through, etc. any character or group of characters.
• Objects, including graphics, pictures, sound clips, video clips, etc. can be inserted quickly and 
easily via Windows' OLE (Object Linking and Embedding v1.0 & 2.0) feature from almost any 
other Windows program.
• Edited .BMP files (via WinPaintbrush and many other programs) can be linked to any 
FormPower master form.
• You can even paste text from your trusty ol' DOS programs via Windows' clipboard.

• FormPower™ is a bargain at an INTRODUCTORY PRICE of only $49.95 +S&I 
(single user)

        NOTE: Normal SRP is $99. Pricing and features subject to change without notice.

$149/$199 (5/10 concurrent LAN/single stations; $20/$15 each additional user).        Introductory 
pricing, SRP is $299/$399... $40/$30.

Call for Multi-user, LAN, Server, Site, Regional and Corporate licensing.

Visa, MasterCard, Discover and American Express accepted @ 1.800.800.2468 (USA toll 
free).
Also accepted via mail or FAX.

Specifications, pricing, etc. are subject to change without notice.

Copyright © 1994-FPW-0705, all rights reserved by:

EZX Publishing & Distributing      (EZX Corporation)
917 Oakgrove Dr., Suite. 101, Houston, TX 77058-3046 USA

(Mailings: PO Box 58177, Webster, TX 77598-8177 USA)

For Information, orders and International:
Voice: 1.713.280.9900 (Business Hours; Central USA time zone)
BBS:      1.713.280.8180 (24hrs; 2400-14400 baud; N81)
FAX:      1.713.280.0099 (24hrs; G3)
FoD:      1.713.280.8300 (24hrs; FAX-on-Demand from your FAX machine handset.)
                                            (Get immediate hard copy information. Request document
                                              number 9999# for a directory of available documents.)

Shipping & Insurance:
$7    USA-48 for ground (7-10 days) shipping. $2 for each additional item.
$12 USA-48 for 2nd business day shipping. $2 for each additional item.
$24 USA-48 for Next Business day shipping. $4 for each additional item.
$12 AK-HI-PR-VI-GU-AS; Canada (all provinces). $3 for each additional item.
$15 Caribbean, Mexico and Central America. $3 for each additional item.
$18 Europe and South America. $4 for each additional item.
$20 Western Pacific Rim, Australia, New Zealand. $4 for each additional item.



$24 Elsewhere. $4 for each additional item.
You can request whatever shipping you wish, such as your own FedEx number, for actual cost 
plus $7 handling charge per order.



Form Design or Fillout
Form Design

The goal here is to create a Master Form by using FormPower's drawing tools to place objects 
at appropriate places on the form.    Once an object is placed, it can be moved, resized or have 
its characteristics modified.

Object characteristics can be selected in two ways.    One way is by setting default 
characteristics via the Options-Defaults menu.    These defaults specify the characteristics of 
newly created objects.    The other method of setting object characteristics is by selecting an 
existing object, then modifying its characteristics with the Form menu.

When a master form is complete, save it.    Once saved it can be reused repeatedly as a 
template for form fillout.

Form Fillout

The goal here is to place data into each field in order to fill out the entire form.    When done 
filling out a form, save it to a unique name



Fillout Command (Edit menu)

When the active form has field objects available for data entry, this menu selection will allow you
to begin entering data into the form.    When saving a form with filled out fields, the form will be 
saved with a .FOF file extension.

Use the File Fillout command instead when the master form has not yet been opened.



Fixed Views (View menu)

Four standard viewing scales are selectable from the View menu and three of the most common
ones are available on the Toolbar.    Two additional custom scales are user-definable in the 
Options-Preferences dialog box and are displayed only in the View menu.

Custom Views (View menu)

The two custom views can be adjusted to your preference.    In the Options-Preferences dialog 
box there are two fields where you define the view scale settings.    Acceptable values are 25% 
through 300%.



Enter the name of the file, or select from filenames below.



Preferences dialog box

Sets defaults for various program operating parameters.    You may temporarily changing 
settings during the current session without saving the settings (Options - Save Settings). In this 
case, the next program startup will use the previous settings.

Click on an area of the dialog box for further explanation.



The position of the Mouse in relation to the form's dimensions will be displayed on the Status 
bar while in fillout mode.



When OFF, once an object is placed after selecting a drawing tool, the tool is deselected and 
select mode will be active.    This is indicated by the mouse cursor changing from a crosshair to 
an arrow.    This automatic drawing tool deselection can be cumbersome when placing multiple 
objects with the same tool.

When ON, the drawing tool is not automatically deselected, so another object of the same type 
can be immediately placed.



When OFF, fields are shown in design mode the same way they will be shown in fillout mode.    
This means that borderless fields will be completely invisible unless selected.    In fillout mode 
this is acceptable since the user will be using Enter or Tab to move to the next field.    In design 
mode, fields aren't always apparent, but they also will not clutter the master form.

When ON, fields are indicated with a red border wrapped around the word "Field".    This is 
probably desirable when placing, moving and resizing fields.



When ON, the Shift+Tab key in fillout mode will move data entry to the previous field.    Tab 
always moves to the next field.

Shift+Enter is always available to move data entry to the previous field.    Enter always moves to
the next field.



The display scale you indicate here will be listed in the View pulldown menu.    Accepted values 
are 25 through 300 percent.



The position of the Pointing Device (mouse) cursor in relation to the form's dimensions will be 
displayed on the Status bar while in fill out mode.



Close All command (Window menu)

Use this command to close multiple opened windows including those that have been iconized.    
You will be asked if you want to save any unsaved forms before closing them.



Form menu commands

With an object is selected, the Form pulldown menu will allow changes to that particular object 
only.    Modifications do not affect any of the other objects on the form.

Text Text margins, justification, etc.
Font Font name, size, etc.
Pen Line/border type and thickness.

Brush Rectangle, RoundRect, and Ellipse backgrounds.
Printable Printed or Non-Printed object.
To Front Places object into foreground.
To Back Places object into background.

Form Layout Adjust form output size.



Pen dialog box

Choose line thickness, style and color for Line, Rectangle, Rounded Rectangle and Ellipse 
objects.    When accessed with the Options-Defaults-Pen menu, pen selections will only affect 
newly created objects.

The pen characteristics of an object can be altered after placement by using the Form Pen 
command, accessible from the main menu or the object popup menu.    The dialog box title will 
not include "Defaults" when modifying an existing object.

Click on an area of the dialog box for further explanation.



Adjust line thickness.    Accepted values are 1 through 10.
For non-solid lines, thickness is fixed to 1.



Adjust the appearance of the line.    The Five choices available are:
Dash
DashDot
DashDotDot
Dot
Solid

Note that line thickness is fixed to 1 for any non-solid line.



Brush dialog box

Choose background fill pattern and color for Rectangle, Rounded Rectangle and Ellipse objects.
When accessed with the Options-Defaults-Brush menu, brush selections will only affect newly 
created objects.

The brush characteristics of an object can be altered after placement by using the Form Brush 
command, accessible from the main menu or the object popup menu.    The dialog box title will 
not include "Defaults" when modifying an existing object.

Click on an area of the dialog box for further explanation.



Fill design, shading effects for shaped objects
Cross Hatch
Diagonal Cross
Downward Hatch
Horizontal Hatch
Solid
Transparent
Upward Hatch
Vertical Hatch



Options-Defaults-Printable

With this option toggled On (check mark visible) all objects placed on the form will be visible and
will print.

With this toggled Off (no check mark), all new objects added will default to non-printable.    With 
this option, an entire form could be designed for screen display only. Nothing will print.

However, you could then add fill-out only fields after turning the Printable attribute back ON. 
Then, text and fields or objects subsequently added will print when the form is printed. That is, 
ONLY the objects added after the Printable attribute is turned on, will print. 

This is how you would set up your form for printing data to pre-printed forms.    This is also know
as CFO (clear forms overlay.)

Caution:  If you do set an Options-Defaults-Printable to be non-printable be sure to reset the 
form design attribute before continuing with the background form design.    Otherwise, the 
remainder of the form will be visible during the rest of the design stage, but will not print.    
Instead, to change the printable attribute of one object, place the object then use the Form 
Printable command described below.

Form-Printable

Any object placed on the form can either be Printable (visible on screen as well as paper 
printouts) or Non-Printable (visible only on-screen and not printed).

Selecting this command will toggle on or off the printable attribute for that particular text, field, or
other object. You can also access this command with the object popup menu.

You can also use this feature to insert special instructions or notations in your form that will 
never be printed.

HINT: Each object can be set to printable or non-printable at any time with the Form-Printable 
command.



Each form window title bar indicates the name of the open form in a highlighted color that is 
different from any other open form window.

Note:    Watch for the asterisk(*) symbol in the title bar at the end of the file name.    This is an 
indication that the form file has been modified.    All changes will be lost if the file is not saved 
before exiting FormPower.



To Front command (Form menu)

Use the To Front command when two or more objects overlap each other.    If the one you want 
fully displayed is partially visible behind another object, highlight the partially hidden object and 
use this command to place it on top of the others.



To Back command (Form menu)

Use the To Back command when two or more objects overlap each other.    If the one you want 
fully displayed is positioned under another, highlight the top object and use this command to 
place it behind all others.



Form Layout dialog box

When accessed via File-New menu, you can adjust the layout with any newly created form, 
regardless of set preferences.

The layout of a form can be altered after creation by using the Form Form Layout command, 
accessible from the main menu.    The dialog box title will not include "Defaults" when modifying 
an existing form.

Choose form size and margins.    When accessed via Options-Defaults-Form Layout menu, the 
layout will only affect newly created forms.

Click on an area of the dialog box for further explanation.



Options menu commands

The Options menu offers the following commands which enable you to set default operating 
parameters for various features of FormPower.

Defaults -Text Attributes, color
Defaults -Font Font, size, attributes, color
Defaults -Pen Thickness, style, color

Defaults -Brush Style, color
Defaults -Printable Toggle On-OFF

Defaults -Form Layout Adjust form output size.
Grid Spacing, ON-OFF, Snap to

Preferences Program features.
Save Settings Saves settings after adjusting program 

defaults



An Inactive form does not have a highlighted title bar.    Click on any visible part of the form to 
make it the active form.    Select the Window pulldown menu for a list of open form file windows.



Form design (Master Form) and data entry (Fillout Form) work area.



Grid dialog box

Use the form design grid settings to help you place objects precisely, and helps to align objects 
vertically and horizontally.    The grid is not visible in fillout mode.

Change grid spacing at any time during the design process for greater form control and visual 
effect.

Click on an area of the dialog box for further explanation.



Horizontal spacing determines how far apart from side to side the grid points are from each 
other.



Vertical spacing determines how far apart from top to bottom the grid points are from each other.



For design mode, toggle the on-screen visible grid ON/OFF.    In fillout mode the grid is always 
off.



When placing, moving or resizing objects, end points are automatically forced to conform to the 
selected grid coordinates.    For example, each end of a Line object will "snap-to" the nearest 
grid point. All four corners of Text, Field and shaped objects will "snap-to" each of the nearest 
grid points, giving you simpler, easier placement capability.    You may also “micro-move” (arrow 
keys) and “mini-move” (Shift plus arrow keys) objects or object sides for even finer control.

The F2 key will toggle this snap-to option while designing a form.



Save Settings (Options menu)

Your fine tuning of the Default, Grid and Preference settings will remain effective only during the 
current session. If you want them to apply to future sessions, they must be saved.    Temporary 
adjustments for the current FormPower session may be made to the options settings for 
repetitive or similar tasks without the need to make those settings permanent.    You must decide
whether or not you will need the new adjustments after you have ended this session.



Operating Tips
Tip # Description

One Structure of this Help file.

Two Separating file types.

Three Using Grid.

Four Inserting OLE object.

Five Multiple open form files.

Six Micro-move and mini-move objects.

Seven Sound Card.

Eight Form Design and Fillout.

Nine Modifying Object Attributes

Ten Graphic Images (.BMP, .PCX, MSP) show as Icon



Separating file types
For your own convenience, you may want to keep certain files separated into different 
subdirectories.

Examples might be:

Use a Pre-Printed Forms subdirectory named      C:\FormPowr\PPF\      for storing all forms that 
have data entry fields, but print only the data and not the background form design.    This type of
master form is used for pre-printed forms purchased from an office supply store, or from a forms
catalog. This type of functionality is also known as CFO (clear forms overlay.)

It is sometimes convenient to place all master forms in one directory, and all fillout forms in 
another.

Other subdirectories may be assigned for departments, specific employees, job/task related 
forms, etc.



Insert New Object dialog box

Used to identify the object file and some associated attributes.

Click on an area of the dialog box for further explanation.



Grid command (Options menu)

Use the Grid dialog box to set grid attributes.    Save the settings as default for newly created 
forms by using the Options-Save Settings command.    You can modify grid spacing as often as 
needed.

You may wish to adjust grid settings for different sections of the form.    The snap-to-grid feature 
helps keep objects lined up and assures a professional appearance to your form.    There will be
times when you will want to turn off the snap-to-grid feature in order to hand place objects that 
do not correspond to any grid.    During form design, the F2 key toggles snap-to-grid on and off.

Micro Move Objects
Note that even when “snap-to-grid” is turned on, you may still “micro-move” objects by using the
cursor keys to move the selected object in very small increments.    To move from gridpoint to 
gridpoint, press Shift and the corresponding cursor key.



Field command (Draw menu)

Field Drawing tool.    Activate by clicking on the Field Toolbar button, or by selecting the Draw-
Field command.    Position the mouse pointer to where you want to begin drawing, press and 
hold the left mouse button while dragging the mouse to draw a rectangle to the desired size of 
the field.    Release the mouse button when done.    When the Snap-to-Grid option is selected in 
the Grid dialog box, the encompassing rectangle's corner points will "snap" to the nearest grid 
points.

You may begin creating data entry fields at any time during Master Form design.

See Also

Modifying Object Attributes



Control menu (Main window)

Top Left tab on Program, Form and Dialog box windows.    Double-clicking on the tab is the 
same as selecting Close from the menu.    Double-click on the Control tab, or use key 
combination Alt-F4 to close the program window, or any displayed dialog boxes.

Restore Restores the window.
Move Reposition the window.
Size Adjust the window size.

Minimize Iconize the window.
Maximize Expand the window.

Close Closes the window.
Switch To Program control tab.    Switches to 

another program.



Text command (Draw menu)

Text Drawing tool.    Activate by clicking on the Text Toolbar button, or by selecting the Draw-Text
command.    Position the mouse pointer to where you want to begin drawing, press and hold the 
left mouse button while dragging the mouse to draw a rectangle to the desired size of the text 
area.    Release the mouse button when done.    When the Snap-to-Grid option is selected in the 
Grid dialog box, the encompassing rectangle's corner points will "snap" to the nearest grid 
points.

Once created, a text cursor will flash in the object on the form to indicate that text can now be 
entered.    When done, the Enter key will end text entry.

To modify it after initial entry, double-click on the text.

See Also

Modifying Object Attributes



Modify the selected object to a different file type using an external program.



Maximize button

Use this button to enlarge the active window to fill available space.    A form window Maximize 
button will expand its window to the size of the FormPower main window, and set it to be the 
active window.    The main window Maximize button will expand the FormPower main window to 
fill the entire screen.

Shortcut
Mouse: Click the maximize icon

 on the 
title bar; or double-click the title bar.

Keys: CTRL+F10 enlarges a form window.



Minimize button

In the main window, use this command to reduce the FormPower window to an icon.    The 
Minimize button of a form window will iconize the active form window and display the icon within
the main window (client area).

Shortcut
Mouse: Click the minimize icon

 on the 
title bar.



Error and Warning Messages
Select one of the following error or warning message topics.    Each will specify whether it 
applies to design mode, fillout mode, or both.    Where possible, remedies are given.

Server is still busy.
There are no fields in this form.    Edit Fillout canceled.
Save option settings?
Save this master form before selecting Edit Fillout.
Are you sure you want to clear the entire form?
Cut to clipboard failed.
Copy to clipboard failed.
Failed to paste object from clipboard.
Failed to create object.
Item on the clipboard has zero size.
Failed to initialize OLE2 libraries.
Error loading AWARE.VBX

This single-user version of FormPower cannot access network drives.    Please contact EZX for 
network pricing information.

This single-user version of FormPower cannot run from a network drive.    Please contact EZX 
for network pricing information.

Error setting system timer.

The FormPower executable file exhibits evidence of tampering.    Unable to continue.    Reinstall 
from original disks.



Server is still busy.
FormPower is currently processing an OLE function and the attempted operation is unsupported
in this mode.

Remedy

Wait for the OLE function to complete.



Border settings for the page are not shown as part of the display during form design.    Settings 
in this area represent a non-printable edge on the indicated side of the paper. The coordinate 
display in the Status Bar includes the borders because the coordinates relate to the entire page.



There are no fields in this form.    Edit Fillout canceled.
Design mode

This error displays when you select Fillout from the Edit pulldown menu and the form does not 
have any field objects defined in it.

The File-Fillout command can also be used to open a master form in order to fill it out.

Remedy

Use the Field drawing tool to create fields on the form.



Save option settings?
If you have modified any of the default settings in the Options menu, this message is a reminder
at program exit to save those changes.    All defaults are saved in the fp.ini file in your Windows 
subdirectory.



Save this master form before selecting Edit Fillout.
Design mode

Before Fillout can function properly there must be an existing master form (.FRM) on the drive.   
Fillout mode reads in the form in a specific manner to provide access to field data entry areas 
only.    When completed, the form in the active window (memory) is saved to a separate file with 
a .FOF file extension.    With this method the master form is not modified and is available for 
future entries containing different data that may be saved to a different .FOF file.

Once saved, data entry fields in .FOF files may be modified at any time. This method may be 
used to clone new filled-out forms that may contain repetitive data.

Remedy

Save the master form, then select the Edit Fillout command.



Are you sure you want to clear the entire form?
Design mode

All objects in the form will be lost.    There is no method for retrieving objects once they have 
been deleted in this manner.

Fillout mode

All fields will be cleared, and the master form will remain intact.    When modifying an existing 
filled-out form, fields are only cleared in memory, leaving the file unchanged.



Access the Color dialog to choose from a given color set.



Cut to clipboard failed.
There may be too many open programs in Windows to complete the action.    System resources 
may be low.

Remedy

Try shutting down some applications and then retry this action.



Copy to clipboard failed.
There may be too many open programs in Windows to complete the action.    System resources 
may be low.

Remedy

Try shutting down some applications and then retry this action.



Failed to paste object from clipboard.
There may be too many open programs in Windows to complete the action.    System resources 
may be low.

Remedy

Try shutting down some applications and then retry this action.



Failed to create object.
Design mode

The object type may not be assigned in the Windows registry profile (REG.DAT). You may need 
to edit the REG.DAT file via the program REGEDIT.EXE.

Remedy

Caution: Consult an experienced Windows user or consultant before attempting this. 
FormPower automatically installs itself in the registry with the installation routines provided on 
the distribution disks. If you did not use the INSTALL program provided with FormPower, the 
registry will not have been updated. Reinstall the proper way. Other programs may not 
automatically update the registry. Consult their respective publishers or distributors for help.



Item on the clipboard has zero size.
The contents of the clipboard has been corrupted.

Remedy

Try pasting the original again.    Make sure there are no programs running that deal with 
intensive tasks such as a spreadsheet recalculation, or image rendering.    Processes that use a 
lot of computer or Windows system resources may restrict other program operations.



Failed to initialize OLE2 libraries.
Appropriate object linking and embedding files are not available.

Remedy

Reinstall the application.



Error loading AWARE.VBX
This file is required for the operation of FormPower. Contact EZX technical support for advice. It 
should be located in your FormPower subdirectory.



Error opening graphic file
File format may not be supported by Windows or FormPower. If accessing file over a network, it 
may be in exclusive or restricted use by another client.



Error reading graphic file
File format may not be supported by Windows or FormPower. If accessing file over a network, it 
may be in exclusive or restricted use by another client.



This single-user version of FormPower cannot access 
network drives.    Please contact EZX/SSW for details on 
the network versions of FormPower and pricing 
information.
Please contact EZX/SSW at 1.713.280.9900 (FAX: 1.713.280.0099) with your requirements, 
and we will forward a custom quotation addressing your particular needs.



This single-user version of FormPower cannot run from a 
network drive.    Please contact EZX/SSW for details on 
the network versions of FormPower and pricing 
information.
Please contact EZX/SSW at 1.713.280.9900 (FAX: 1.713.280.0099) with your requirements, 
and we will forward a custom quotation addressing your particular needs.



Error setting system timer.
Windows has apparently lost critical synchronization. Please save and close all applications, as 
well as Windows.

Remedy

Reboot your computer and restart Windows.



The FormPower executable file exhibits evidence of 
tampering.    Unable to continue.    Reinstall from original 
disks.
This error could occur after a system crash, unexpected power interruption, compression 
corruption, software virus attack, as well as many other sources.    The program is no longer 
usable and must be reinstalled.    The executable file has been corrupted.    Copy your master 
forms (.FRM) and filled out forms (.FOF) to a secure floppy.    Remove the FormPower icons and
group from Windows. Delete all other files relating to FormPower. Then reinstall.

When reinstalling FormPower, make sure the distribution disks are write protected. If a virus is 
suspected, run one of the many available anti-virus programs for a diagnosis.

Note: All EZX/SSW programs are virus free when shipped from EZX. As we have no control of 
their handling after leaving EZX, we disclaim all responsibility for same.



Using Grid
You are not limited to one grid setting during the design of a form.    Adjustment of horizontal and
vertical grid settings can be made at any time to within two decimal places,      0.25      0.37      
0.50      and so on.    If the grid setting is changed, all previously set objects will not “snap-to” the 
new grid unless selected and moved with the new grid settings in place and “snap-to-grid” 
turned on.    The "snap-to-grid" feature is defaulted to ON upon program installation.

“Snap-To-Grid” means that while you are moving or sizing an object (e.g. creating a line) the 
end points will “snap-to” the nearest grid point intersections around the object.    If the entire 
object is selected, it will “snap-to” the nearest grid coordinates. Or if just one of the “handles” on 
a corner or side is selected, only it will snap-to-grid when released. The “snap-to-grid” feature 
can be turned on or off at will via the Options-Grid dialog box.    The F2 key also toggles the 
“snap-to-grid” feature.

Note:    Even if snap-to-grid is turned on, you may still micro-move a selected object with the 
keyboard arrow keys as long as the object is still selected. This allows for very precise 
positioning of the object.

You may also use mini-move by depressing and holding the Shift key while making 
movements with the cursor keys. If “snap-to-grid” is turned on, the movements here are actually 
from gridpoint to gridpoint. If “snap-to-grid” is turned off, then the movement is the same as 
micro-move.

Varying text sizes, lines, boxes, other shapes and imported graphics may need different grid 
settings to place them precisely where you want them.



Control menu (Form window)

The main FormPower window and the Form and Dialog box windows all have a control menu 
tab in the top left corner.    Double-clicking on the tab is the same as selecting Close from the 
menu.

Restore Restores the window.
Move Reposition the window.

Size Adjust the window size.
Minimize Iconize the window.
Maximize Expand the window.

Close Closes the window.
Next From control tab.    Switch to another open

form within FormPower.



This number indicates the number of days between automatic reminders of probable 
FormPower upgrades.    The reminder message will reappear every 7-180 days (you select) in 
order to remind you that it may be time to get the latest version of FormPower. This is not meant
to nag you, but to gently remind you that we may have bigger and better things in the works.



Object Change Icon dialog box

Click on the appropriate area of the dialog box for further explanation.



Object Insert Browse dialog box

Click on an area of the dialog box for further explanation.



Inserting OLE objects
OLE objects can be inserted into a master form by using the Edit-Insert New Object command.   
Object Linking and Embedding (OLE) means that an object (data or file) can be embedded or 
linked to another application that doesn't directly support the object format.    The application that
does support the object format is called the OLE server.    The application that can embed or 
link to OLE objects is called an OLE client or OLE container.    FormPower is an OLE 
container application.

Linking requires a file, which can reside in any subdirectory on any disk drive.    When the file is 
changed by the OLE server application, FormPower can be set to update the link either 
manually or automatically.    An automatic link is immediately updated in FormPower.    Updating 
a manual link requires use of the Edit Links command      Each type of link serves a different 
purpose, to be determined at master form design time.    When using a manual link, the object's 
data is stored directly into the form, along with the original file name.    With an automatic link, 
only the object's file name is stored into the form.

Embedding does not require a file.    An object can be created at insertion time, or loaded from 
an existing file.    The embedded object becomes part of the master form file, and the data can 
only be changed through FormPower, via the OLE server application.

Image files, sound files, and video files are examples of objects that can be embedded into a 
FormPower form by using the Edit-Insert New Object command.

There are several example files containing a selection of images that you may find useful.    The 
images stored in filenames IMAGE*.FRM (or .FOF) can be transferred from the original file to a 
form you are designing with copy (Ctrl-C) and paste (Ctrl-V).



Structure of this Help file
Introduction

Describes the capabilities of and features available in FormPower.    Read through the 
Introduction for a quick primer on the power and utility of FormPower.

Overview

This section of the Help file begins with a display of FormPower's main (client) window.    Click 
the left mouse button on a portion of the display and you will see a pop up screen.    Clicking on 
a highlighted word or phrase in the pop up screen will jump from the current screen to a topic 
description.    Additional detail of the specific topic or related topics may also be available 
through other topics, which are highlighted.

Basic structure of Overview section:
FormPower display    -->    Pop Up    -->    Topic description    -->    Detail description.

A left mouse click on a special area of an image displays a pop-up screen.    The pop-up gives a 
short description of the area.

Browse buttons located in the Help window toolbar begin functioning after the first FormPower 
pulldown menu selection.

Example: From the Overview display click on menu selection File and a pop up screen shows 
the available menu choices.    Click on New and Help will jump to the specific topic description.    
The Help window's Browse button [>>] will scroll through the related File pulldown menu topic 
descriptions.    Return to Overview by clicking on the Help window's [Overview] toolbar button.    
Begin another browse sequence from any of the other FormPower pulldown menu selections as
well as the Program Control and Form Control menus.    Control menus are activated by clicking 
on the tab located at the top-left corner of either the program window or the form window.    The 
Error Message section contains a browse sequence, and another browse sequence is setup for 
the detail description areas.

Operating Tips
Suggestions, ideas, latest updates, etc. relating to specific features and benefits of FormPower.

Hot keys
Quick key operation using the Ctrl, Alt, and/or Function keys available as listed.

Error Messages
Explanation of some of the error messages you are likely to encounter.



Multiple open form files.
It may be helpful at times to have several forms open at once for comparison, work in progress, 
or to copy/move text, fields, or objects from one form to another.    Too many open forms may 
clutter up your screen desktop.    Iconizing (minimizing to icon view) some of the forms using the
Minimize command contained in the Control tab menu for the form window can clean things up 
considerably.

One example of the convenience of multiple open forms is in the case of cloning (or duplicating)
an existing form (master or fill-out) and modifying it for a slightly different use while preserving 
the original form.    To do this, use “File-Save As” to save the form to a new and different name. 
The original form is saved and closed for safety. You may reopen the original with the File-Open 
command or Toolbar icon in order to keep it on-screen for reference.    You can even open 
another form that has an image (like a logo or signature) that you would like to copy to your new
form.    Highlight the image in the third open form and select the Edit-Copy command.    The 
image is stored in the Windows' clipboard and can be pasted into the new form.    Click on the 
new form that is to contain the image and select the Edit-Paste command. The object will 
immediately appear in the new form with all attributes identical to the original.

Available system memory and system resources have a lot to do with being able to transfer 
images.    If problems occur, select the image and position the mouse cursor on the bottom right 
corner object handle (tab).    Press and hold the left mouse button and drag the corner to make 
the image smaller.    Repeat the transfer steps then increase the images size after moving it to 
the other form. If this is not sufficient to move the image, you may need to shut down some of 
the other applications you currently have running in Windows.



Micro-move objects.
Often times you will need an object positioned between grids.    You can use FormPower's 
micro-move feature to fine tune the form.    Micro-move works whether or not “snap-to-grid” is 
turned on or off via the Options Grid command snap-to-grid selection.

To use this feature, select an object and use the arrow keys to micro-move it to a new position.   
Shift-arrow key (mini-move) will move the object from grid point to grid point if “snap-to-grid” is 
turned on.    If “snap-to-grid” is turned off, the the movement is actually the same as micro-move.

Do NOT continue to hold the mouse button after you have selected the object as this will cause 
the object to snap back to the defined grid if you have “snap-to-grid” turned on.

After dragging an object halfway across the form to a new location, sometimes the mouse is a 
bit difficult to use for precise placement with “snap-to-grid” toggled OFF.    In this case you can 
drop the object very close to the position desired and use micro-move to fine tune the 
placement.

Note:    Even if snap-to-grid is turned on, you may still micro-move a selected object with the 
keyboard arrow keys as long as the object is still selected. This allows for very precise 
positioning of the object.

You may also use mini-move by depressing and holding the Shift key while making 
movements with the cursor keys. If “snap-to-grid” is turned on, the movements here are actually 
from grid point to grid point. If “snap-to-grid” is turned off, then the movement is actually the 
same as micro-move.



Lists the available choices to convert the object to.



Identifies the type of object currently selected.



If available, select this option to change the OLE object type.



If available, choose a different OLE server to associate with the object.



An icon representation is used.for objects that cannot be displayed, such as sound files.    You 
can use a different icon with the Change Icon button.



Helpful message displays appear after choosing a conversion type before committing to action.



Create a new OLE object and place it into the form, by choosing the OLE server that will 
maintain it.



Select an existing object file listed to the right.    Use Browse to search for the file.



Shows the full path and file name to be inserted into the form.    Either enter the filename, or use
the Browse button to locate the file you want.



Link an OLE object to the form.    Unselect this item to embed the object in the form.



Helpful, explanatory messages displayed in this section.



Displays the currently used icon for the object.



Select the default icon as the one to associate with this OLE object.



Select an icon from any .ICO, .EXE or .DLL icon library.



Images of available icons stored within the library file.



You can modify the label used beneath the icon.



Displays the selected icon image.



Refresh command (View menu)

Use Refresh to update the screen at any time. This may be necessary when artifacts are 
caused by the Windows GDI or some video drivers during busy or complex editing sessions.

Shortcut

Keys Ctrl+R



“TestDrive“ refers to a fully functional version of FormPower that is meant for evaluation of 
same, much like you test drive an automobile before you purchase it. Also, just like a test drive, 
the salesman usually comes along. So you may have to put up with occasional “commercials” 
asking you to purchase (a.k.a. regi$ter) the program.

The TestDrive edition of FormPower is functionally identical to the full or registered version. 
However, only two forms may be opened simultaneously.

Regi$tering removes all TestDrive screens. Please feel free to “share” TestDrive editions ONLY 
of FormPower with your associates.

Please help us keep the cost of software low by NOT SHARING registered versions of 
FormPower with anyone within the limits of the license granted to legitimate purchasers by EZX.



We are constantly striving to improve the operation, versatility and user productivity of 
FormPower for Windows.    You may be interested in the latest program enhancements. You 
may also wish to license multiple copies and/or a Local Area Network version.

Call EZX/SSW at 1.713.280.9900 (FAX: 713.280.0099) for information concerning new features,
benefits, etc..    Be sure the registration card has been properly filled out and mailed in to us.    
As a courtesy to registered users we offer special upgrade pricing on all versions of FormPower.

If you have a registered version of FormPower, be sure the registration card has been properly 
filled out and mailed in to us.
EZX Corp., PO Box 58177 -fp, Webster, TX 77598-8177 USA

For immediate FAX-back information, you may call our FAX-on-Demand systems 24 hours a 
day at 1.713.280.8300 from your FAX machine handset. Request document number 9999 for a 
directory of available literature.



A reminder for FormPower TestDrive edition users that the program was developed at least one 
year ago. Certain features may now be completely disabled, but none of your forms will ever be 
lost. You just will not be able to save any new changes.

Call for latest information concerning product version, pricing and added features.    We accept 
Visa, MasterCard, Discover and American Express via the phone.

We are constantly striving to improve the operation, versatility and user productivity of 
FormPower for Windows.    You may be interested in the latest program enhancements. You 
may also wish to license multiple copies and/or a Local Area Network versions.

Call EZX/SSW at 1.713.280.9900 (FAX: 713.280.0099) for information concerning new features,
benefits, etc.

If you have a registered version of FormPower, be sure the registration card has been properly 
filled out and mailed in to us.
EZX Corp., PO Box 58177 -fp, Webster, TX 77598-8177 USA

For immediate FAX-back information, you may call our FAX-on-Demand systems 24 hours a 
day at 1.713.280.8300 from your FAX machine handset. Request document number 9999 for a 
directory of available literature.



Window Size

Size command (Control menu)

Use this command to display a four-headed arrow so you can size the active 
window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the 
pointer to the border you want to move.
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut

Mouse: Drag the size bars at the corners or edges of the window.



FormPower History
A record of modifications to Formpower since the July 12, 1994 initial release.

( After any changes are made to the program, this help topic can be listed as jumpword 
FormPower History from the Contents for user access. Remove this paragraph before 
providing user access. )

July 12, 1994 Initial program release.



Select command (Draw menu)

Actives select mode.    Click on the Select Toolbar button, or choose either the Edit-Select or 
Draw-Select commands.    Once in select mode, an object is selected by placing the mouse 
cursor anywhere on the object and clicking the left mouse button.    A selected object can be cut,
copied, moved, resized or have its attributes modified.



Help File History
A record of modifications to this help file since the July 12, 1994 initial release.

( After any changes are made to the help file, this help topic can remain unaccessable to end-
users and still be a part of the file for inhouse records.    Program suggestions and bug reports 
could also be stored here since no end-user will be able to access this screen.)

07-13-94 Blue
1 Added two topics to the help file.    FormPower History topic for end-user access to 
indicate any modificatons to the program.    Help File History for inhouse use.to keep trake of 
change to this file.

2 Andy made changes, but I have not be told what they are and could not find them 
quickly.



Text command (Form menu)

Modify text attributes for the selected object by using the Text command in the Form menu or 
the object popup menu.

See Also

Text dialog box
Font dialog box



Brush command (Draw menu)

Modify background/fill attributes for the selected object by using the Brush command in the 
Form menu or the object popup menu.    This displays the Brush dialog box.



Font command (Form menu)

Modify font attributes for the selected object by using the Font command in the Form menu or 
the object popup menu.

See Also

Font dialog box
Text dialog box



Pen command (Form menu)

Modify line or border attributes for the selected object by using the Pen command in the Form 
menu or the object popup menu.    This displays the Pen dialog box.



Printable command (Form menu)
Any object placed on the form can either be Printable (visible on screen as well as paper 
printouts) or Non-Printable (visible only on screen and not printed).

Form-Printable
Selecting this item will toggle on or off the printable attribute for the currently selected text, field, 
or graphic object.    This command is also accessible from the object popup menu.

You can also use this feature to insert special instructions or notations in your form that will 
never be printed.

HINT: Each object can be set to printable or non-printable at any time with the Form-Printable 
command.

Options-Defaults-Printable
With this option toggled On (check mark visible) all objects placed on the form will be visible and
also print.

With this toggled Off (no check mark), all new objects added will default to non-printable. With 
this option, an entire form could be designed for screen display only. It will not print.

However, you could then add fill-out only fields after turning the Printable attribute back ON. 
Then, text and fields or objects subsequently added will print when the form is printed. That is, 
ONLY the objects added after the Printable attribute is turned on, will print. 

This is how you would set up your form for printing data to pre-printed forms.    This is also know
as CFO (clear forms overlay.)

Caution:  If you do set an Options-Defaults-Printable to be non-printable, be sure to reset the 
form design attribute before continuing with the background form design.    Otherwise, the 
remainder of the form will be visible during the rest of the design stage, but will not print.



Form Layout command (Form menu)

The Form Form-Layout command will display the Layout dialog box.    During form design, the 
form's size, margins, etc. may be modified to accommodate the paper or printer (some printers 
do not support all margin settings) you are using.



Text command (Options-Defaults menu)

The settings assigned in the Options-Defaults-Text dialog box are used to set defaults for all 
newly created text and field objects.



Pen command (Options-Defaults menu)

Settings assigned in the Options-Defaults-Pen dialog box are used to set defaults for all newly 
created line, rectangle, rounded rectangle and ellipse objects.



Form Layout command (Options-Defaults menu)

The settings assigned in the Options-Defaults-Form Layout dialog box are used to set defaults 
for all newly created forms.



Brush command (Options-Defaults menu)

The settings assigned in the Options-Defaults-Brush dialog box are used to set defaults for all 
newly created rectangle, rounded rectangle and ellipse objects.



Preferences command (Options menu)

The settings assigned in the Options-Preferences dialog box are used to set defaults for 
program operations.    These settings determine the way master forms and filled out forms 
function as you use them.

This is also where you can assign two custom view scale (25-300%) settings available in the 
View menu.



Getting Started
This documentation assumes a working knowledge of Windows and its user interface.    Our on-
going goal is to always provide user interface ease, simplicity and consistency within 
FormPower, as well as consistency with other Windows applications.    This will serve to help 
you get started as quickly and easily as possible.

To get started, first learn the terminology, then read about what commands to begin with, then 
read about how FormPower's on-line help is organized.

Terminology

Form
Master Form
Design Mode
Fillout Form
Fillout Mode
Object
Drawing Tool
OLE Object

What to do

In FormPower, you are currently working in the Main Window without any active forms.    Here 
are at least three ways to get started, listed here in order of complexity.

1) Load an existing fillout form in order to fill it out or modify it.    Try ezxinfo.fof.    Use the File 
Open command, type

 ezxinfo.fof
and then select OK.    F1 will display fillout help.    Now fill out some fields.    When ready, save it 
with the File Save command.    Or use File Save As to save it with a different file name, leaving 
the original file unchanged.
2) Load an existing master form in order to fill it out.    Try invoice.frm.    Use the File Fillout 
command, type
invoice
and then select OK.    F1 will display fillout help.    Now fill out some fields.    When ready, save it 
with the File Save command and specify a unique name.
3) Create a new form with File New and design a new master form.    Press F1 for design help.    
Select a drawing tool and place an object using the mouse.    Place text, fields and graphics in 
the same manner.    When ready, save it with the File Save command and specify a unique 
name.

On-line Help

In general, on-line help is available at any time by pressing F1.    The help that appears will be 
context sensitive, meaning that it will apply to the current place in FormPower.    Overall, there 
are three ways to access help.    They are:

F1 select a command then 
press F1 to get context 



sensitive help
Shift+
F1

press Shift+F1, then 
choose a screen element, 
toolbar button or menu 
item on which to get help

Help 
menu

select a general topic



The FormPower program mode that allows creation and modification of Fillout Forms.



The basic unit of a form.    An object is created by a drawing tool in design mode, and is saved 
into a Master Form.    Objects have attributes, and can be modified in various ways.



A specific type of form, created with FormPower from a Master Form.    A unique Fillout Form file
exists for each form that is filled out.    All Fillout Form files have an extension of .FOF.



The FormPower program mode that allows creation and modification of Master Forms.



A FormPower feature that creates objects.    To place an object, first select a drawing tool, then 
position the mouse pointer to where the top leftmost point of the object will be and press the left 
mouse button.    Then continue to hold the left mouse button and drag the mouse pointer to the 
bottom rightmost point of the object.    Finally, release the left mouse button.    If snap-to-grid is 
on, the object's end points will automatically move to the nearest grid points.



A specific type of form created by FormPower in design mode.    A Master Form represents a 
blank form, to be copied and filled out time and time again.    All Master Form files have an 
extension of .FRM.



OLE is an acronym for Object Linking and Embedding.    In short, OLE allows an object created 
by an OLE server (such as Paint, Excel, etc.) to be embedded into an OLE client application, in 
this case FormPower.    This very powerful feature allows placement of graphics, sound, video or
other objects onto a FormPower form.



Modifying Object Attributes
An object can have one or more of the following attribute groups:

Text
Font
Pen
Brush
Printable

Each of these attribute groups except for Printable, has an associated dialog box that allows 
modification of the attributes within that group.    Printable is a simple on/off toggle.

An object is created by first selecting a drawing tool, then using the mouse to place and size it.   
At creation time, an object's attributes are defined by settings in the Options-Defaults menu.    
These defaults are saved in the FP.INI file in your Windows directory.    For example, the 
Options-Defaults-Text command accesses the Text dialog box for the text default attributes.

Once an object exists, its attributes can be modified at any time in design mode by altering 
settings that are accessible via the Form menu or the object popup menu.    These settings are 
saved with the object in the Master Form (.FRM) file.    For example, when a rectangle object is 
selected, the Form-Pen command accesses the Pen dialog box for the Pen attributes of the 
selected rectangle.



Graphic Images (.BMP, .PCX, MSP) show as Icon
Problem: A graphic image always shows up as an icon.

Cause: Another program has improperly modified the OLE registration data file.

Solution: Print this Help Topic if necessary and follow the sequence below.

Note: This procedure assumes that you are using the Windows Paintbrush program to support 
graphic images.    If you are using a different program, substitute the appropriate names below.

1. With the Program Manager File - Run command, select the file named REGEDIT.EXE 
located in the Windows subdirectory and add to the command line a space, forward slash and 
the letter " V ".    Click the OK button.
[    REGEDIT.EXE /V    ]

2. In REGEDIT, press the Home key to position the cursor at top of data.

3. Maximize the program window by clicking on the Top-Right corner arrow of the program 
window, then select the Edit - Add key command.

4. A dialog popup requires entry of the following.    Be sure you start the Key: entry with a 
period as an indicator of a specific file extension.

Key: .BMP

Value: PBRUSH

5. Press the Home key to position the cursor at top of data again.

Repeat the process from step # 3 to add the following two file extensions to the list.

Key: .PCX

Value: PBRUSH

The final addition to the data structure should look like this.
Be sure to press the Home key before adding.

Key: .MSP

Value: PBRUSH

After the three file extensions have been added to the top of the data structure, select File - 
Save Changes.    Exit the program and restart Windows.

Check that the changes did correct the BMP to Icon Link by first starting FormPower.    Open a 
New form.    Insert an Object with a .BMP file extension.    Check that the .BMP image shows as 
it is, not as a "Paint" icon.








